SAP R/3 Information Session

By Martin O'Reilly
# Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Procedures</td>
<td>2</td>
</tr>
<tr>
<td>Structure of GUI</td>
<td>6</td>
</tr>
<tr>
<td>Basic Navigation</td>
<td>8</td>
</tr>
<tr>
<td>Getting Help</td>
<td>12</td>
</tr>
<tr>
<td>Reporting Basics</td>
<td>13</td>
</tr>
<tr>
<td>Exercises</td>
<td>18</td>
</tr>
</tbody>
</table>
Login Procedures

You will be provided with a client number, username, and password to access the system. This information will either be sent to you via email if you have submitted the application for an account, or provided to you at the time of your information session.

When you arrive at the lab execute the icon named SAPLogon.

SAPlogon.Ink

You should then see a system named Rutgers IDES or something similar. You should then select the logon button at the top right of the SAP logon screen. After connecting to the system you will see the following screen:
Use the following parameters for logon:

**Client:**
You will be provided with a specific client to logon to. A client is a separate data environment within SAP. You must use the client number provided for you or your attempts to login to the system will fail.

**User:**
Your login name will also be provided to you.

**Password:**
Your initial password will also be provided to you via email or verbally at your session.

*After entering these items press enter.*

You will be prompted to change your password upon your first successful login to SAP. **Please document the password that you enter at this point.** Please note that you cannot use the same password. (see image below)

If you are going through this information on your own, feel free to explore the R/3 system. This will make the upcoming SAP information sessions more interactive.

Please note that the Rutgers SAP system is part of University Computing environment and therefore is subject to all of the restrictions outlined in the Rutgers University Acceptable Use Policy. For additional information on this policy, please see the following link: [http://rucs.rutgers.edu/acceptable-use.html](http://rucs.rutgers.edu/acceptable-use.html)

After your successfully login to the system for the first time, you will see the following screen:
You will need to enter your new password twice here -> please document this for future reference.
After the initial password issue has been resolved you will see a welcome message like the one below:

Select the check mark or press enter to continue
Structure of the GUI

**SAP Easy Access Menu**

**Command Field**

The command field is an integral part of using the SAPGui. By default this item is hidden and you must press the Right arrow next to the enter icon in order to have it displayed. This field will be used to enter transaction codes associated with various functions within SAP.
Favorites

You can use the favorites folder to hold transactions, reports, files, and web sites that you use most often.

Tree Structure

The SAP Easy Access Menu uses a tree structure that allows for easy navigation. You can simply drill down to explore the modules within SAP.

Status Bar

The status bar at the bottom of the screen provides system messages and session information. The session information is located at the right hand portion of the status bar and provides important information about the current session. Please note that you may have to press a right arrow button at the very right of the status bar in order for this information to appear. A session is a separate instance of SAPGui and one can have up to six sessions active at a time.

Icons

The following icons are seen throughout the system and are provided here as a reference.

The standard toolbar contains buttons for performing common actions such as Save and Enter.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Enter" /></td>
<td>Enter</td>
<td>Confirms the data you have selected or entered on the screen. Same function as the Enter key. Does not save your work.</td>
</tr>
<tr>
<td><img src="image" alt="Command field" /></td>
<td>Command field</td>
<td>Allows you to enter commands, such as transaction codes.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>Saves your work. Same function as Save in the Edit menu.</td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Back" /></td>
<td>Back</td>
<td>Returns you to the previous screen without saving your data. If there are required fields on the screen, these fields must be completed first.</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Exit</td>
<td>Exits the current function without saving. Returns you to the initial screen or main menu.</td>
</tr>
<tr>
<td><img src="image" alt="Cancel" /></td>
<td>Cancel</td>
<td>Exits the current task without saving. Same function as Cancel in the Edit menu.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Prints data from the current screen.</td>
</tr>
<tr>
<td><img src="image" alt="Find" /></td>
<td>Find</td>
<td>Searches for data required in the current screen.</td>
</tr>
<tr>
<td><img src="image" alt="Find next" /></td>
<td>Find next</td>
<td>Performs an extended search for data required in the current screen.</td>
</tr>
<tr>
<td><img src="image" alt="First page" /></td>
<td>First page</td>
<td>Scrolls to the first page. Same function as the CTRL + Page Up keys.</td>
</tr>
<tr>
<td><img src="image" alt="Previous page" /></td>
<td>Previous page</td>
<td>Scrolls to the previous page. Same function as the Page Up key.</td>
</tr>
<tr>
<td><img src="image" alt="Next page" /></td>
<td>Next page</td>
<td>Scrolls to the next page. Same function as the Page Down key.</td>
</tr>
<tr>
<td><img src="image" alt="Last page" /></td>
<td>Last page</td>
<td>Scrolls to the last page. Same function as the CTRL + Page Up key.</td>
</tr>
<tr>
<td><img src="image" alt="Create session" /></td>
<td>Create session</td>
<td>Creates a new SAP session. Same function as Create session in the System menu.</td>
</tr>
</tbody>
</table>
Create shortcut

Allows you to create a desktop shortcut to any SAP report, transaction, or task if you are working with a Windows 32-bit O/S.

F1 Help

Provides help on the field where the cursor is positioned.

Layout menu

Allows you to customize the display options.

Source SAP Library

**Basic Navigation**

Navigation through the SAP system is performed through the use of the SAP Easy Access Menu tree structure and transaction codes. In addition the Favorites folder can be used to link directly to specific reports, transactions, and web sites to increase productivity.

**SAP Easy Access Menu**

The SAP Easy Access Menu provides an intuitive tree based structure that can be used to drill down to specific transactions and reports. Due to the size of the system, it is recommended that you use favorites or transaction codes for your navigation.

**Role Based Menu Generation**

The items within your Menu are created based on your user role within SAP R/3. Therefore different users have different menus created for their designated function within their respective company.

**Transaction Codes**

The use of transaction codes allow one to navigate directly to functions within the R/3 system. Transaction codes are called through the following methods:

- From the Sap Easy Access Menu simply enter the transaction code and press enter.

  For example, enter FD03 and press enter. Press the cancel button to return to the SAP Easy Access Menu.
• From any other screen within the system you must use one of the following prefixes:

/n ends the current transaction

For example, from the SAP Easy Access Menu enter FS10N. Now enter the transaction code /nFD03 which will end the current transaction and open the Display Customer initial screen.

/o opens a new session with the specified transaction -- you may have a total of six sessions open at one time.

Determining Transaction Codes

You can easily find the transaction code of a specific function by choosing system from the drop down menu → status. This will provide the transaction code in the transaction field listed under repository data.

Another way to help you determine transaction codes is to customize your interface. You can do this via the following procedure:

From the SAP Easy Access Menu select Extras from the drop down menu. Then choose Settings and you will see the following screen:

Choose the show technical name setting and then press enter or select ✓.

Now when you navigate through the system the transaction codes will be visible.
**Favorites**

You can use the favorites folder to hold commonly used transactions, reports, and hyperlinks. You can drag and drop specific items to your favorites folder, or you can create them manually.

**Adding a hyperlink to your favorites folder**

As an example, we will add a hyperlink to the Functions in Detail link.

From the drop down menu select Favorites → add web address or file

Leave default: Web address or file & press enter

In the text field enter: Functions in Detail

In the Web address or file enter [http://highpoint.rutgers.edu/sap/index.htm](http://highpoint.rutgers.edu/sap/index.htm)

Then press enter or select continue

Test your newly created link in your favorites section to confirm that it works. Simply double click the Functions in Detail entry and a browser should open up to this web site.

**Customizing Your User Profile**

Before you start you should customize your user profile for your own preferences. To access this area use the drop down menu item system → User Profile → Own data

Under address data edit the necessary under title, first name, and last name.

Select the defaults tab and change the following items:

- Personal Time Zone → change to EST
- Decimal Notation → Select the second entry
- Date Notation → Select the second entry

Select Save
Getting Help

There is an extensive amount of help within the SAP R/3 system.

Use F1 for help on fields, menus, functions, and messages

Use F4 for information on what you can enter into a text boxes

There is also an extensive amount of information located within the SAP library. You can access this from the system by the following action:

Select Help from the drop down menu → SAP Library. A separate window will then open up with the SAP Library open. This library provides extensive information on SAP R/3 and the IDES enterprise organization.

This library is also accessible via the web at the following url:

http://www.sap.rutgers.edu/student_resources.html

Functions in Detail

This resource contains the SAP Functions in Detail brochures for specific mySAP.com Application Components, IDES (Internet Demonstration and Evaluation System) and mySAP.com Industry Solutions. They provide an in-depth reference with business and technical information for project team members, managers, consultants, and future SAP customers.

(Source SAP Functions in Detail CD)

This resource is currently available at the following URL:

http://www.sap.rutgers.edu/student_resources.html
Reporting Basics

Extracting information from the R/3 is one of the most useful aspects of having an integrated enterprise based information system. There are a number of ways to attain reports.

First, many of the most popular reports are provided for you under the information systems heading in the SAP Easy Access Menu. From here the reports are grouped by application.

You can then drill down to the respective area you would like reports for and choose the report.

You will find an information systems item listed in certain modules that will provide the same information.
Another way to attain a report is to choose system from the drop down menu
→ System → Services → Reporting or transaction code SA38.

The report selection screen appears:
The following screen then appears

<table>
<thead>
<tr>
<th>Program</th>
<th>Authorization group</th>
<th>Application</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. In the Program field, enter any part of the report name that you know, plus any wildcards ( * or + ), as needed.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>* and +</td>
<td>Characters you do not know</td>
</tr>
<tr>
<td>*</td>
<td>Multiple characters</td>
</tr>
<tr>
<td>+</td>
<td>Exactly one character</td>
</tr>
</tbody>
</table>

Use the * and + anywhere in the report name, as often as necessary. For example:
<table>
<thead>
<tr>
<th>Character</th>
<th>Represents all report names...</th>
</tr>
</thead>
<tbody>
<tr>
<td>z*</td>
<td>Starting with z</td>
</tr>
<tr>
<td><em>sale</em></td>
<td>Containing the character string sale, such as rvsale07</td>
</tr>
<tr>
<td>*f+</td>
<td>Containing an f as the second-to-last character, such as rmlogifa</td>
</tr>
<tr>
<td>rp+++sch</td>
<td>Starting with rp, ending in sch, and containing any three characters in between, such as rp012sch or rpinvsch</td>
</tr>
</tbody>
</table>

The report name can be upper- or lowercase; for example, RF is the same as rf.

*Most standard reports start with the letter R, while customer generated reports should start with either Y or Z.

As an example enter RVA*.

2. Choose Execute or press F8

A list of reports appears.

3. Place the cursor on the report name, and choose Choose. Or, double-click the report name.

To continue with our example scroll down until you see RVAUFRUE and double click on this report name.

4. Choose Program → Execute.

If the report does not require a variant, the selection criteria screen for the report appears.

If the report requires a variant, the system displays a message stating that you cannot select the report from this screen. Return to the report selection screen (press F3), and then enter the report and variant name. Before leaving this screen, note the name of the report.

5. Enter the selection criteria. For our example do not enter any additional selection criteria.

6. Choose Program → Execute.

Right click on GIDate and select sort.
What is the oldest backorder document number and to what Ship to Party does this belong?

Select the exit button twice to return to the SAP Easy Access Menu.
Exercises

Exercise 1

Objective:

To View information regarding a customer and to view and record the total receivables for this customer as per a specific date.

Why? A manager has called you to confirm the amount of open receivables at a specific date in time. The manager only left the account number, so you first want to see what customer information is available.

From IDES SAP Easy Access Menu:

Menu Path
Logistics → Sales and Distribution → Master Data → Business Partners → Customer → Display → Sales and Distribution
Transaction Code (VD03)

Enter Customer Account Number 3574

Select the Continue Button or use the Enter key

Where is this company located? _____________________

In the transaction field enter /nF.21 which ends the current transaction and opens the List of Customer Open Items

The same customer account number and company codes should be displayed automatically. If not, enter 3574 for the account number.

Set the date to 01/15/2000

Select the Execute button or use the F8 key.

What is the total open receivables on this date? __________
**hint you may have to scroll to the right.

Exit back to the Easy Access Menu.
Exercise 2

Objective: To Determine the cash position of a company within the enterprise.

Why? You are a sales manager that is trying to fulfill an order through one of your suppliers, however you have been informed that you are on credit hold until invoices are paid or the order will be sent via COD. Prior to addressing this issue with your manager you would like to view the current cash position for a possible COD order.

Menu Path

Information Systems → Accounting → Treasury → Treasury: Strategic View → Liquidity Analysis → Cash position

Or Transaction code FF7A

Company Code 3000
Cash Position Checked
Grouping BANKS US
Display as of Today's Date
Display In USD
Increment in D/W/M /1/
Scaling 3/
Select Execute (clock with the check in front of it)

What is the current Citibank Balance? __________

How is the output incremented? ________________

Exit back to the Easy Access Menu
Exercise 3

Objective:

To view the balance sheet of one of the companies in the IDES group and to document requested information concerning this document.

Why? You are an IDES accounting manager that reports to the CFO and you regularly meet with the presidents of the various companies to review key figures.

Menu Path
IDES → IDES Reports → Profit Center Accounting →

Select Report with Balance Sheet Key Fig.

Enter the following parameters:

Fiscal Period 1999

Company Code 3000

To Period 12

Leave the default entries in the Selection Group Section

Select the Execute button or use F8

Which profit group excluding the dummy profit center has the greatest Net Working Capital?

_________________________________

Which profit group has the greatest Current liabilities?

_________________________________
Exercise 4

Objective:

To view a cost center report and document requested information with such a report.

Why? As a manager you may be asked to help a client reduce costs. You are currently evaluating the cost centers of the company and are reviewing specific costs.

Menu Path
Accounting → Controlling → Cost Center Accounting → Information System → Reports for Cost Center Accounting → Plan/Actual Comparisons

Select Report: Cost Centers: Actual/Plan/Variance

In Controlling Area enter 2000

In Fiscal Year Enter 1997

From Period 1

To Period 12

Plan Version 0

Or Value(s) 2200

Select Execute or hit F8

Who is group 2200? ________________

What was the actual cost for office supplies? ________________

What was the planned amount for office supplies? ________________

What is the variance? ________________

How is the abs. Variance percentage calculated? _________________________

Could you have gotten to this report in other ways? If so list them:
Exercise 5

Objective:

The purpose of this exercise is to use the drill down features available in SAP to attain data from a report. In addition, the office integration feature of SAP will be displayed providing this information in spreadsheet form. Finally a pie chart will be created based on information from the P&L.

Why? You are currently evaluating Sales costs for an upcoming meeting that will focus on reducing sales costs for company 3000.

Menu Path
IDES → IDES Reports → Financial Accounting →
IDES Cost of Sales P&L

1. Enter the following selection values:
   - Period from 1
   - Period to 2
   - Fiscal Year 1999
   - Company Code 3000
   - Ledger 0F
   - Plan Version 1
2. Select Execute or hit F8
3. Use the controls on the left side of the screen to expand and collapse the information
4. Collapse all possible items
5. What is the only item left and the amount? ________________
6. Expand the items necessary to find the production credit for WIP. What is the amount listed under act.local? ________________
7. Expand all the possible items in this report
8. Right click on the report and select office integration
9. Select Microsoft Excel and leave the Worksheet protection box checked
10. Select Continue and choose yes when prompted for macro approval
11. You can probably write your memoirs here as the processing time may become lengthy-- Notice once it does come up that you have an Excel spreadsheet embedded in SAP R/3!

12. What is the number of the last row in this spreadsheet? _______

13. Can you sort the data in column C? _______

14. Find the data entries that pertain to Administrative Costs

15. Highlight these subcomponents in Column B & C and Select the Chart Wizard button on the Excel toolbar (hint you should have highlighted seven entries)

16. Select Pie from the chart type selection screen and use the default pie chart option → select next

17. Leave series listed in columns and select next

18. For the Chart Title enter Cost of Sales P&L Admin Costs 1999

19. Under legend select show legend at bottom

20. Under data labels tab choose show percent and select next

21. Place chart as new sheet and click finish

22. Review this Pie Chart and ensure it is accurate.

23. Select Back and choose to exit the report when prompted. If you get an error choose end

24. When prompted to exit the report select yes.

25. Select Back again and you should be at the SAP Easy Access Menu
Exercise 6

Objective:
The purpose of this exercise is to use an existing report in the system to determine information related to a transaction.

Journal: Transactions with cash flows

Description
This report displays cash flows for predefined transactions using ALV functions. At present, the product categories in Money market and Foreign exchange as well as CAPs, FLOORs, FRAs, SWAPs and OTC options are represented.

In addition to the usual cash flow data, the output list contains information about the activity category and posting status of the respective flows and further data can be added if necessary. The sort takes place by default according to the company code, transaction number, activity, payment date and transaction flow.

In interactive reporting, you can branch to the display of the corresponding transaction by selecting a line.


2. On the Journal: Transactions with cash flows screen enter the following data:
   company code 1000
   Currency:  EUR
   Choose Execute

3. For Transaction 29, there is an entry from 4/17/02 for Nominal interest for CP. What is that amount in EUR?: ____________________ What is that amount in UNI? ________________

   Using the interactive reporting functionality described in the caption above, what is the interest rate for this
Exercise 7

Objective:

The purpose of this exercise is to use an existing report in the system to determine and document specific and unique information.

Analyzing Reports in Cost Center Accounting

4. From the SAP Easy Access Menu, choose Accounting → Controlling → Cost Center Accounting → Information System → Reports for Cost Center Accounting → Plan/Actual Comparisons → Cost Centers:Actual/plan/variance

5. On the Cost Centers: Actual/Plan/Variance: Selection screen, enter the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controlling area</td>
<td>1000</td>
</tr>
<tr>
<td>Fiscal year</td>
<td>1998</td>
</tr>
<tr>
<td>From period</td>
<td>01</td>
</tr>
<tr>
<td>To period</td>
<td>12</td>
</tr>
<tr>
<td>Plan version</td>
<td>000</td>
</tr>
<tr>
<td>Cost center group</td>
<td>H1000</td>
</tr>
<tr>
<td>Cost element group</td>
<td>OAS</td>
</tr>
</tbody>
</table>

6. Choose Variation and ensure that Explode is selected.

7. Select the Details icon and ensure that the following items are entered:

<table>
<thead>
<tr>
<th>Field</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>1</td>
</tr>
<tr>
<td>To</td>
<td>99</td>
</tr>
</tbody>
</table>
These settings ensure that the cost center hierarchy is expanded completely. You can now navigate along the hierarchy and access the line items if required.

8. Choose **Continue**.

9. On the **Cost Centers: Actual/Plan/Variance: Selection** screen, choose **Execute**. Please note that this report will take a few minutes to generate.

10. Expand the entries under cost center H1420 Production

11. List your login ID here __________

12. Use your Login ID to determine the answers for these questions. Specifically, use the nth entry down based on your login. For example, if you are rbsv.ar1 then use the first entry. There are 23 entries. If your ID is greater than 23, then start at the top of the list. For example, user ID 25 would use the second entry down or specifically 4205 Work Preparation.

13. Select the appropriate cost center and document the cost center number and description here:

   ______________________________________________________

14. For Cost Element 42000 Direct Labor Costs enter the following information for your cost center. If your assigned cost center is 4255 Scrap paints, use the raw materials line item instead.

<table>
<thead>
<tr>
<th>Act. Costs</th>
<th>Plan Costs</th>
<th>Absolute Variance</th>
<th>Var. (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

15. Use the interactive reporting feature of SAP to drill down into this direct labor cost line item and choose actual line items when prompted. What is the largest entry listed under Val. in rep. cur.? ____________________________

Can you find the document date for this entry? If so, what is it? _______________